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ABSTRACT 

 

This proposal introduces an innovative Augmented Reality (AR) application, 

"Augmented Reality Exploration of Human Femur," aimed at revolutionizing the 

understanding and analysis of femur fractures. Traditional methods of studying femur 

anatomy often lack the interactivity and precision needed for detailed exploration, 

which this AR application seeks to address. By integrating advanced AR technology 

with meticulously crafted 3D models, the application will allow medical professionals, 

educators, and students to virtually dissect and examine the femur in real-time, 

enhancing the comprehension of its complex structures and fractures. The development 

will be conducted using Unity, with Blender refining the 3D models for anatomical 

accuracy, and C# programming executed in Microsoft Visual Studio. Firebase will 

support data storage and management, facilitating user interactions and educational 

modules. The expected outcome is a user-friendly, immersive tool that sets new 

standards in medical education and clinical practice, improving diagnostic accuracy and 

treatment planning. 

 

 

 

Area of Study (Minimum 1 and Maximum 2): Augmented Reality (AR) 

 

Keywords (Minimum 5 and Maximum 10): Femur Fracture, Medical Education, 

Fracture Analysis, Augmented Reality (AR), AR in Healthcare 
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CHAPTER 1 

Introduction 

The foundation of this research is rooted in the critical intersection of technology and 

medical science, specifically focusing on the exploration of human femur fractures through 

Augmented Reality (AR). Fractures of the human femur pose significant challenges in 

diagnosis, treatment planning, and medical education [1]. Traditional approaches often 

lack the precision required for a thorough understanding of femur anatomy and fractures. 

The motivation for our research stems from the pressing need to address these challenges 

and leverage innovative technologies to enhance medical practices. 

 

1.1  Problem Statement and Motivation 

The medical field is confronted with a critical challenge in the diagnosis, treatment 

planning, and educational understanding of human femur fractures. Traditional approaches 

often fall short in providing the necessary precision to fully comprehend the complexities 

of femur anatomy and fractures, which can lead to suboptimal medical practices and patient 

outcomes [2]. This inadequacy underscores a pressing need for innovative solutions that 

can bridge the gap between medical science and advanced technology. Despite the 

increasing prevalence of femur fractures, there is a notable scarcity of dedicated tools and 

applications that enhance understanding and interaction with this vital aspect of human 

anatomy. This is particularly evident in the realm of Augmented Reality (AR), where the 

potential to create immersive and dynamic learning experiences remains largely untapped. 

The lack of advanced tools not only hampers precise diagnosis but also limits the 

availability of effective educational resources, thereby impeding the medical community's 

ability to address femur fractures efficiently. 

 

Motivated by these challenges, this project seeks to develop an AR application that focuses 

specifically on femur anatomy and fractures, filling a crucial gap in the resources available 

for medical education. The proposed application aims to introduce AR interactivity to the 
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study of femur fractures, allowing users to visualize and understand these fractures in three-

dimensional space with an unprecedented level of detail and realism. By offering a hands-

on experience, the application is designed to enhance comprehension, improve diagnosis, 

and support better treatment planning. Furthermore, recognizing the financial constraints 

faced by students and medical enthusiasts, the application will be developed as a free 

resource. This ensures wider accessibility, enabling a broader audience to benefit from the 

educational content, thereby revolutionizing the way femur fractures are studied and 

understood in both educational and clinical settings. 

 

 

1.2  Objectives 

Develop an Interactive AR Experience: 

• Real-Time Exploration: Enable users to interact with detailed 3D models of femur 

fractures in real-time, providing a dynamic and immersive experience. 

• Comparative Analysis: Enable users to compare different types of femur fractures 

side by side, helping them to understand the variations and implications of each 

fracture type. 

• Enhanced Visualization: Provide high-resolution, interactive 3D visualizations of 

femur fractures to help users visualize the impact and progression of various 

fracture types. 

Provide Comprehensive Bone Information: 

• Detailed Anatomy: Offer extensive information about the femur bone's structure, 

including key features such as joints, attachments, and surface landmarks. 

• Fracture Mechanics: Include educational content on how different fractures affect 

the bone's function and integrity. 
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Increase Application Coverage: 

• Diverse Fracture Types: Incorporate a wide range of femur fracture types, from 

simple to complex, to cover various clinical scenarios. 

 

1.3  Project Scope and Direction  

The "Augmented Reality Exploration of Human Femur Fractures" project aims to address 

critical challenges in the diagnosis, treatment, and education surrounding femur fractures 

by leveraging Augmented Reality (AR) technology. Traditional methods often lack the 

precision needed for an in-depth understanding of femur anatomy and fractures, leading to 

less effective medical practices. This project seeks to bridge this gap by developing an AR 

application that offers a dynamic and immersive experience. Users will be able to interact 

with high-resolution 3D models of femur fractures in real-time, virtually dissect the bone, 

and explore its intricate structure and various fracture types. The application will provide 

comprehensive information on femur anatomy, including key features like joints and 

attachments, and educational content on fracture mechanics. By incorporating a wide range 

of fracture types, the application will cater to diverse clinical scenarios, enhancing both 

educational and diagnostic capabilities. Recognizing the financial constraints of students 

and medical enthusiasts, the application will be developed as a free resource, ensuring 

broader accessibility and impact. The project will utilize Unity for AR development, 

Blender for 3D modeling, and Microsoft Visual Studio with C# for programming. 

Comprehensive testing and user feedback will guide refinements, ensuring an effective and 

user-friendly tool that revolutionizes the study and understanding of femur fractures in 

medical education and clinical practice 
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1.4 Contributions 

The project contributes significantly to the field of medical education and practice by 

addressing several key areas. 

Firstly, Accessibility and Cost-Efficiency is a major contribution. The application is 

developed as a free resource, which addresses financial constraints faced by students and 

medical enthusiasts. This ensures broader accessibility and democratizes the availability of 

advanced educational tools, making high-quality learning resources available to a wider 

audience. 

 

Enhanced Learning Experience is another crucial contribution. By integrating Augmented 

Reality (AR) technology, the project offers a dynamic and immersive learning experience. 

Users can interact with detailed 3D models of femur fractures in real-time, which enhances 

their understanding and retention of complex anatomical and fracture information. 

 

The project also provides Advanced Visualization Tools. The application features high-

resolution, interactive 3D visualizations of the femur and its fractures, allowing users to 

visualize and analyze fractures from various angles and perspectives. This improved 

visualization helps users better comprehend the impact and progression of different types 

of fractures. 

 

Finally, the project supports Medical Education and Practice by filling a crucial gap in 

existing educational resources. It specifically focuses on femur fractures, providing a tool 

that aids in improved diagnosis, treatment planning, and medical education. This 

contributes to better patient outcomes and more effective medical training, addressing a 

significant need in the medical field. 
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1.5 Project Background 

The foundation of this research is rooted in the critical intersection of technology and 

medical science, specifically focusing on the exploration of human femur fractures through 

Augmented Reality (AR). Fractures of the human femur pose significant challenges in 

diagnosis, treatment planning, and medical education. Traditional approaches often lack 

the precision required for a thorough understanding of femur anatomy and fractures. The 

motivation for our research stems from the pressing need to address these challenges and 

leverage innovative technologies to enhance medical practices. 

 

1.6 Human Femur 

Let's embark on a journey into the intricate realm of the human femur, the central 

protagonist of our project. Commonly referred to as the femoral bone, the human femur 

stands as the longest and strongest bone in the human body, forming a vital component of 

the skeletal framework. It is responsible for a couple important task for human being. 

Foremost among its roles is the formidable task of bearing the weight of the entire body 

during both standing and movement, underscoring its significance in providing structural 

support. Beyond its load-bearing prowess, the femur plays a pivotal role in stabilization, 

acting as a steadfast anchor that ensures balance and equilibrium during various 

movements. Additionally, the femur acts as a vital connector, intricately linking muscles, 

tendons, and ligaments in the hip and knee regions to the broader physiological network of 

the body. This interconnected web of support facilitates coordinated movements and 

underscores the femur's indispensable contribution to the overall functionality of the 

human musculoskeletal system.
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Figure 1.6-1 Location of Femur and its characteristic 

 

Figure 1.6-2 Bone Cartoon illustration 

 

Human femur is the one and only bone located in our thigh, running from our hips to our 

knee. Based on figure 1.1.1-1, we can observe the outer structure of the of the femur. The 

outer structure of the femur exhibits a distinctive and robust composition, characterized by 

two rounded ends and a lengthy shaft in the middle, resembling the classic shape often 

depicted in cartoon illustrations—a cylindrical form with two rounded protrusions at each 

extremity (Figure 1.1.1-2) [1]. Despite its appearance as a singular elongated bone, the 

femur is intricately segmented into several key parts, each serving specific functions in 

maintaining the bone's structural integrity and supporting various physiological activities. 
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At the upper (proximal) end of the femur, which connects to the hip joint, lies the proximal 

aspect housing essential components such as the head, neck, greater trochanter, lesser 

trochanter, and the intertrochanteric line and crest. These elements collectively 

contribute to the articulation and connection of the femur with the hip, forming a crucial 

junction for weight-bearing and mobility. 

 

The long portion of the femur, known as the shaft, extends downward, supporting the 

body's weight and forming the structural framework of the thigh. This section features key 

anatomical landmarks, including the linea aspera, gluteal tuberosity, pectineal line, and 

popliteal fossa, all contributing to the bone's strength and functionality. The shaft angles 

slightly toward the center of the body, optimizing its role in weight distribution and 

movement. 

 

The lower (distal) end of the femur constitutes the top of the knee joint, where it meets the 

tibia (shin) and patella (kneecap). This distal aspect includes crucial structures such as the 

medial and lateral condyles, medial and lateral epicondyles, and the intercondylar fossa, 

forming pivotal connections that facilitate joint movements and ensure stability. 

 

While these intricate parts and labels are typically employed by healthcare providers to 

describe specific areas of concern, such as pain or issues, they collectively contribute to a 

comprehensive understanding of the femur's outer structure. In instances of a femoral 

fracture, these terms become particularly relevant as healthcare professionals utilize them 

to precisely identify and communicate the location of bone damage for effective diagnosis 

and treatment.  
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Figure 1.6-3 Anatomy of Femur 

 

Figure 1.6-4 Side View of the cross-section of femur 
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This structural marvel encompasses three distinct layers, each playing a crucial role in the 

bone's function and resilience. At the outermost layer lies the periosteum, akin to the 

outside skin of the bone. This thin, whitish skin is densely packed with nerves and blood 

vessels, serving as a vital conduit that supplies the cells responsible for building the robust 

bone beneath. 

 

Beneath the periosteum, the femur reveals its dense and rigid layer known as compact bone. 

Resembling a cylinder, this layer is exceptionally hard, requiring the precision of a saw 

during surgical procedures. The compact bone, resembling a honeycomb with myriad tiny 

holes and passageways, accommodates nerves and blood vessels. These intricate pathways 

ensure the supply of oxygen and nutrients to the bone, facilitating its essential functions. 

Remarkably, the compact bone does not experience pain despite its density, as it consists 

predominantly of calcium and minerals. 

 

Upon cutting through the compact bone, the innermost layer, known as spongy bone 

marrow, is unveiled. This layer, encased within the medullary cavity—a central cavity 

within bone shafts—holds a gelatin-like substance. The medullary cavity is integral to the 

production and storage of yellow bone marrow, also known as adipose. In infants, the 

marrow appears red due to active blood cell formation within the cavities. This dynamic 

marrow contributes to the generation of red blood cells, white blood cells for immune 

response, and platelets for blood clotting 

The harmonious interaction of these three layers, coupled with the intricate network of 

nerve signals and blood streams coursing between them, underscores the femur's 

remarkable biomechanics. Thigh bones, pound for pound, exhibit strength surpassing that 

of reinforced concrete. Within the femur, an intriguing feature known as the epiphyseal 

line marks a strip of relatively less dense bone in long bones, highlighting the dynamic 

nature of bone structure and growth
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1.6.1 Causes of Femur Fractures 

Femur fractures, being a serious and often traumatic injury, can be attributed to a range of 

causes, with the two most common factors being high-speed trauma and pre-existing bone 

diseases [2]. High-speed trauma scenarios, such as motor vehicle or motorcycle accidents, 

falls from significant heights, or injuries sustained during extreme or contact sports, place 

immense force on the femur, leading to fractures. The abrupt and forceful impact associated 

with these events can result in the femur succumbing to the intense mechanical stress, 

causing a break in its structural integrity. 

 

On the other hand, pre-existing bone diseases contribute to femur fractures by 

compromising the strength and density of the bone. Conditions like tumors, Paget disease, 

bone cysts, and osteoporosis weaken the structural integrity of the femur, making it more 

susceptible to fractures even under normal or less severe circumstances. In the case of 

osteoporosis, the gradual loss of bone density over time renders the femur more prone to 

fractures, particularly in individuals with advanced age. 

 

Figure 1.7.1-1 Differences between Healthy Bone and Osteoporosis Bon
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1.7 Types of Femur Fractures 

1.7.1 Femoral Shaft Fractures 

 

Figure 1.7.1-1 Different types of Femoral Shaft Fractures 

Femoral shaft fractures exhibit a diverse array of patterns, each offering unique insights 

into the nature and magnitude of the forces that lead to such injuries. 

 

One of the most common femoral shaft fractures is Transverse fractures, characterized by 

a straight horizontal break, typically result from direct forces applied perpendicular to the 

femur's longitudinal axis. 

 

On the other hand, oblique fractures showcase an angled line along the shaft, indicating the 

influence of angular forces during the traumatic event. The distinctive candy cane-like 

appearance of spiral fractures signifies a rotational or twisting force impacting the thigh. 
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Comminuted fractures, with the bone fragmenting into multiple pieces, often signify high-

energy trauma, emphasizing the severity of the applied force. 

After that, Linear fractures in the femoral shaft occur when there is a straight, horizontal 

break across the bone. The line of the fracture runs perpendicular to the long axis of the 

femur. These fractures can result from a direct impact or force applied to the femur. 

Besides, Greenstick fractures are incomplete fractures, common in pediatric populations 

where bones are more flexible. In a greenstick femur fracture, the bone is bent, causing a 

crack on one side while the other side remains intact. This type of fracture resembles the 

way a green twig breaks, hence the name. 

Among these, open or compound fractures present a particularly intricate scenario, where 

a bone fragment breaches the skin or a wound extends to the fractured site. Such fractures 

involve heightened complexity, as the risk of complications, especially infections, is 

elevated, demanding thorough clinical attention. Recognizing and understanding the 

nuances of these femoral shaft fractures is essential for orthopedic practitioners to tailor 

effective treatment plans, ensure optimal patient outcomes, and advance the field's 

knowledge in fracture biomechanics.  
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Table 1.8.1-1 Types of Common Fractures

Transverse Fractures 

 

Figure 1.7.1-2 Transverse Fracture (a) 

 

Figure 1.7.1-3 Transverse Fracture (b) 

• Complete Fractures 

• Straight horizontal break 

• Cause by direct Forces 

• Applied perpendicularly 
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Oblique Fractures 

 

Figure 1.7.1-4 Oblique Fractures (a) 

 

Figure 1.7.1-5 Oblique Fractures (b) 

 

• Complete Fracture 

• Angled line along the shaft 

• Cause by angular forces 
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Spiral Fractures 

 

Figure 1.7.1-6 Spiral Fractures (a) 

 

Figure 1.7.1-7 Spiral Fractures (b) 

• Complete Fracture 

• helical or corkscrew-shaped 

break pattern that encircles the 

bone 

• Caused by twisting or 

rotational force applied to a 

bone 
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Comminuted Fractures 

 

 

Figure 1.7.1-8 Comminuted Fractures (a) 

 

Figure 1.7.1-9 Comminuted Fractures (b) 

• Complete Fracture 

• The bone is broken into 

several pieces 

• Cause by severe trauma such 

as vehicle accidents or high 

fall 
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Linear Fractures 

 

Figure 1.7.1-10 Linear Fractures (a) 

 

Figure 1.7.1-11 Linear Fractures (b) 

• Incomplete Fracture 

• straight, non-displaced break 

in the bone 

• Caused by direct trauma or 

force applied to the bone 
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Greenstick Fractures 

 

 

Figure 1.7.1-12 Greenstick Fractures (a) 

 

 

Figure 1.7.1-13 Greenstick Fractures (b) 

 

 

 

 

 

 

 

 

• Incomplete Fracture 

• A partial break in the bone, 

causing it to bend 

• Caused by trauma or injury 
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Open Fractures 

 

 

Figure 1.7.1-14 Open Fractures 

• Complete Fracture 

• broken bone penetrates 

through the skin, exposing 

the fracture site to the 

external environment. 

• Caused by high-impact 

injuries, severe trauma, or 

accidents, such as car 

crashes or falls from 

significant heights. 
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1.7.2 Neck of Femur (NOF) Fractures 

The femoral neck, being the slender region connecting the femoral head to the shaft, is 

recognized as the femur's weakest segment [3]. The implications of fractures in this critical 

area extend beyond the structural compromise, as they directly impact the blood supply to 

the femoral head, carrying substantial morbidity risks. Accurate diagnosis and 

classification of femoral neck fractures become paramount in navigating the complexities 

of their management. These fractures are broadly categorized into three types based on 

their anatomical locations: 

 

Subcapital Fractures: Situated at the femoral head/neck junction, subcapital fractures mark 

a crucial area where the integrity of the femoral neck is compromised. 

 

Transcervical Fractures: Manifesting in the midportion of the femoral neck, transcervical 

fractures pose distinct challenges, necessitating tailored approaches in diagnosis and 

treatment. 

 

Basicervical Fractures: Positioned at the base of the femoral neck, basicervical fractures 

add another layer of complexity to the classification spectrum. While debate persists in the 

literature regarding their precise categorization as intracapsular or extracapsular, prevailing 

wisdom often leans toward treating them as extracapsular fractures. 
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Table 1.1.4-1 Major Types of NOF Fractures 

Subcapital: femoral head/neck junction 

 

Figure 1.7.2-1 Subcapital (a) 

 

Figure 1.7.2-2 Subcapital (b) 
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Transcervical: midportion of femoral neck

 

Figure 1.7.2-3 Transcervical (a) 

 

Figure 1.7.2-4 Transcervical (b) 
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Basicervical: base of femoral neck

 

Figure 1.7.2-5 Basicervical (a) 

 

Figure 1.7.2-6 Basicervical(b) 
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1.8  Report Organization 

The report outlines a project developing an Augmented Reality (AR) application for 

studying femur fractures. Chapter 1 introduces the problem and motivation behind the 

project, sets objectives, defines the project's scope and direction, and highlights 

contributions such as enhanced accessibility and learning experiences. Chapter 2 reviews 

existing AR applications and technology in healthcare, assessing their impact and 

relevance. Chapter 3 details the proposed method, including system requirements, design 

diagrams, and a project timeline. Chapter 4 presents preliminary work, covering software 

setup and initial results. Finally, Chapter 5 concludes with a summary of findings and 

future direction.
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CHAPTER 2 

Literature Reviews 

2.0 Augmented Reality in HealthCare 

Augmented Reality (AR) has emerged as a transformative technology that enriches the 

real-world environment with digital overlays, creating interactive and immersive 

experiences [3]. By seamlessly integrating virtual elements like images, sounds, and other 

sensory stimuli into the physical world through holographic technology, AR offers a 

dynamic interaction that blurs the lines between the digital and tangible realms. Its defining 

features include the coexistence of digital and physical worlds, real-time interactivity, and 

precise 3D identification of virtual and real objects. In recent years, AR has made 

significant strides in healthcare, reshaping the industry's landscape. 

Augmented Reality (AR) is reshaping healthcare, offering innovative solutions across 

various medical realms [4]. Its impact is profound, enhancing medical imaging precision, 

transforming education and training, and improving patient outcomes. 

 

2.0.1 Key Uses of AR in Healthcare 

Surgical Assistance: AR enables surgeons to create 3D models of patient organs or tumors, 

providing real-time holographic guidance during surgery. Surgeons benefit from 

superimposed directions, minimizing errors. 

 

Remote Guidance: In complex cases, doctors leverage live video calls and audio headsets 

for expert opinions. Specialists remotely guide doctors through procedures, fostering better 

treatment. 

 

Medical Training: AR facilitates immersive training for medical practitioners and students. 

Remote mentors provide guidelines, improving skills and knowledge in real- time. 
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Diagnosis and Imaging: AR aids in 3D annotations and remote visual assistance for 

accurate patient diagnoses. Full-body scans visualize symptoms, reducing the need for 

extensive personal protective equipment. 

  

Telehealth Advancements: The growth of telehealth is accelerated by AR, allowing remote 

consultations with augmented views of patients. Physicians use AR overlays for 

examinations, diagnoses, and guidance. 

 

Vein Visualization: AR handheld scanners and near-infrared imaging assist in visualizing 

veins for blood collection, improving the success rate of injections. 

 

2.0.2 Impact of AR in Healthcare: 

Enhanced Medical Imaging:  

An Augmented Reality (AR) based navigation system for surgical operations works by 

overlaying digital information onto the real-world environment, specifically tailored to 

assist in surgical procedures [5]. 

 

Enhance Remote Guidance: 

utilizes a head-mounted display to enable mentors to view real-time video streams of 

surgical procedures from the trainees' side. The AR system provides a 3D visualization of 

the surgical scene, offering a more intuitive and immersive experience compared to 

traditional 2D video or text-based communication [6]. 

 

Medical Education and Training: 

 AR revolutionizes medical education by providing interactive learning experiences. 

Surgeons and medical students use AR simulations for surgical practice and anatomical 

exploration [7]. 
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Seamless Hospital Navigation:  

AR wayfinding applications simplify hospital navigation, providing step-by-step directions 

and floor plans for patients, visitors, and medical staff. 

 

Empowering Physical Therapy:  

AR offers interactive exercises and visual feedback for physical therapy and rehabilitation, 

improving patient engagement and therapy outcomes. 

 

Robotic-Assisted Surgery: 

 AR enhances the precision of robotic-assisted surgeries by providing real-time overlays of 

critical information, guiding surgeons and improving surgical outcomes.[8] 

 

2.1 Technological Review 

2.1.1 Review of AR types 

 

An AR visualization application for fractures of the neck of the femur has been developed 

specifically for Mixed Reality (MR), necessitating the use of a headset such as Microsoft's 

HoloLens [8]. However, the cost of such headsets is prohibitive, and their convenience in 

most scenarios is limited. Therefore, it would be advantageous to create such an application 

for a more universally accessible device—mobile phones. But first let’s determine which 

type of AR tracking we are planning to implement. There are many types of AR that can 

be implemented, some of them are Markers-Based, Location-Based, World- based or 

SLAM, and Body Tracking [9]. 

Marker Based AR are a very commonly used for developing AR in application [10]. Due 

to its simplicity in implementing and its higher accuracy in position. By linking each virtual 

product to a specific marker, the algorithm in the AR SDK will extract the geomatic 

features from a given marker and match it to the corresponding product. Then the marker 

will act as a reference for the display of the virtual object in the screen 

The next AR we are going to talk about is Location-Based AR. This form of AR enables 

virtual objects to be anchored in the real world based on points of interest using GPS or 
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geolocation data. One notable and popular example of a Location-Based AR application is 

Pokémon GO [11]. In this game, players explore their physical surroundings, and the game 

dynamically overlays virtual Pokémon and game elements ont o the real- world map, 

creating an immersive and interactive experience tied to specific locations. 

 

Up next, World-Based or SLAM AR detects visually distinct features in the captured 

camera image called feature points and uses these points to compute its change in location. 

By aligning the pose of the virtual camera that renders your 3D content with the pose of 

the device's camera. Virtual content able to be render in the correct perspective. By using 

the following formula to remove white noise in non-edge regions for each raw depth image, 

bilateral filter is first applied [12]. 

  

 

Figure 2.1.1-1 Calculation for Depth 

Then the initial pose estimation, accelerometer is used to measure the rotation of the mobile 

device by the following equations: 

 

Figure 2.1.1-2 Calculation for Estimation of Device 

In simple term, it means that the algorithm will first generate an environmental map, then 

is will determine the location of the device inside the environment [13]. 
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Last but not least, Body tracking in augmented reality (AR) refers to the ability of AR 

systems to recognize and track the movements and positions of a user's body in real- time. 

This technology enables the overlay of virtual objects or information onto the user's body, 

creating interactive and immersive experiences. Body tracking AR can be applied in 

various contexts, from entertainment and gaming to fitness and healthcare [14] 

 

 

 

 

 

Table 2.1.1-1 Types of AR 

Types of AR Necessary to generate tracker 

beforehand 

Complexity 

Marker Based AR ⟋ Simple 

Location-based AR × Simple 

World tracking/ SLAM × Intermediate 

Body tracking AR × Intermediate 
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2.1.2 Review of AR SDK 

There are a few AR Software Development Kit (SDK) available can be used to develop in 

Android Operating System (OS), Each of them is Unity AR Foundation, Vuforia by PTC 

and ARCore. All of these SDK can be integrated into Unity Engine which is perfect for this 

project since it was built on Unity Engine. 

Table 2.1.2-1 ARSDK 

Unity AR Foundation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• AR Foundation is a package 

that lets you build cross- 

platform AR applications in 

Unity3D. 

• you can develop your AR 

application in Unity3D and 

then build it either for 

Android or iOS. 

• Vast community support, 

easy access to Unity3D 

codebase & asset store 

 

if your project generates more than 

$100K over year, Unity3D Pro license 

will cost you from $40 to $150 per 

month. 
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Vuforia 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• one of the oldest AR 

companies on the market 

• Vuforia Engine has been 

directly integrated with 

Unity3D, making it easier to 

create AR projects directly 

inside the game engine. 

• Vuforia developers were able 

to create a medical AR 

application that took a 

patient's 3D-printed heart as 

a marker model and built 

several layers of anatomy 

over it 

• Pricing is higher compared to 

other AR tools. The 

subscription starts at $42 / 

month. However, you can 

develop for free until the app 

is deployed. 
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ARCore 

 

 

 

 

 

 

 

 

 

 

 

• ARCore was primarily 

focused on Android as the 

main platform for creating 

AR experiences. This target 

was only natural, given that 

both were developed by 

Google. 

• offers three main features: 

Motion Tracking, 

Environmental 

Understanding and Light 

Estimation 

• Free 
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2.2 Review of Previous Application 

 

Similar application is AR anatomy by Virtual medicine, s.r.o., Skeleton by Catfish 

Animation Studio, Complete Anatomy 2023 by 3D Human Body Atlas & Courses and also 

Anatomyka Skeleton by Woodoo Art s.r.o 

 

2.2.1 AR anatomy 

 

Figure 2.2.1-1 AR Anatomy Menu   Figure 2.2.1-2 AR Anatomy Description of Bones
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Figure 2.2.1-3 AR Anatomy in AR View Figure 2.2.1-4 AR Anatomy 

Selected Femur 

 

 

Figure 2.2.1-5 AR Anatomy Isolate Femur 
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AR Anatomy presents a comprehensive educational package tailored for a seamless  

learning experience across various devices, including mobile phones, tablets, and desktop 

or laptop computers. This educational tool encompasses detailed representations of all 

human body systems, such as skeletal, muscular, nervous, cardiovascular, respiratory, 

digestive, reproductive, lymphatic, and connective tissues. The package goes beyond static 

representations, providing users with multiple interactive functions, including the ability 

to combine, layer, and highlight specific anatomical features. One of the standout features 

of AR Anatomy is its advanced Augmented Reality (AR) Mode, which empowers users to 

position a detailed human body model directly into their real-world environment. This 

mode enhances the learning experience by allowing users to interact with anatomical 

structures in a tangible and immersive way. For educational institutions such as universities 

and secondary schools, AR Anatomy offers a Cross-platform Multi-User collaboration 

mode. This feature enables lecturers to conduct virtual classes where students can connect 

to the teacher's online lecture. The collaborative environment includes real-time video 

streaming and voice transmission, creating an engaging and interactive learning 

atmosphere for all connected students. 

 

What sets AR Anatomy apart is its commitment to accessibility. Even without a Virtual 

Reality (VR) headset, users can still benefit from the augmented reality mode. This feature 

enables the placement of anatomical models directly into the user's real-world 

environment, providing a 3D perspective of more than 13,000 structures and animations. 

Each anatomical element is accompanied by detailed descriptions, making this a 

comprehensive educational resource that fits right in your pocket—accessible anytime and 

anywhere. 

 

In essence, AR Anatomy revolutionizes anatomy education by combining cutting-edge 

technology with detailed anatomical representations, fostering an immersive and 

interactive learning experience for students and educators alike.  
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PROS 

This application boasts robust support for marker less Augmented Reality (AR), allowing 

users to deploy AR experiences seamlessly in any environment without the need for 

specific markers. This flexibility enhances the user experience, enabling the application to 

be used effortlessly in diverse settings. 

 

Notably, the application goes beyond traditional AR functionalities by offering the 

capability to isolate and interact with 3D models. This means users can not only visualize 

but actively engage with anatomical structures, providing a hands-on and immersive 

learning experience. 

 

A standout feature that distinguishes this application from similar ones is its support for 

multiple user collaboration mode in AR. This collaborative environment enables users to 

connect and participate in real-time collaborative sessions. In an educational setting, for 

instance, this mode allows a lecturer to conduct virtual classes where students can 

simultaneously view, interact with, and discuss anatomical models. The inclusion of real- 

time video streaming and voice transmission fosters a dynamic and interactive learning 

atmosphere, setting this application apart in the realm of collaborative AR experiences. 

 

CONS 

One notable limitation of the application is the absence of a note-taking feature, which 

hinders users from documenting their insights or additional information during the learning 

process. This deficiency can be a drawback for users who wish to personalize their learning 

experience by recording specific observations, questions, or annotations related to 

anatomical structures. 
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Additionally, when isolating a particular part for focused study, the available information 

appears to be brief and general. The lack of specific details and comprehensive information 

about the selected part may limit the depth of understanding for users seeking more detailed 

insights into anatomical components. Moreover, the inability to select or choose the name 

and characteristics of the part could hinder users from accessing specific details crucial for 

a thorough understanding of anatomy. 

 

2.2.2 Skeleton 

 

Figure 2.2.2-1 Skeleton Menu Figure 2.2.2-2 Skeleton Lower Limb Menu 
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Figure 2.2.2-3 Skeleton 3D view    Figure 2.2.2-4 Skeleton Femur Selected 
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Figure 2.2.2-5 Skeleton Femur Isolated   Figure 2.2.2-6 Skeleton Shaft of Femur Selected 

 

"Skeleton - 3D Atlas of Anatomy" stands as a revolutionary resource in the realm of 

anatomy education, offering an immersive and interactive experience through its advanced 

features. This next-generation anatomy atlas delves into the intricacies of the human 

skeleton, presenting users with highly detailed 3D anatomical models. The ability to 

effortlessly rotate and zoom in on each bone provides a dynamic exploration, allowing 

users to observe anatomical structures from any angle. With surfaces of the skeleton 

boasting textures of up to 4K resolution, the visual fidelity enhances the depth of 

understanding. 

Navigating this comprehensive atlas is made simple and intuitive, empowering users to 

explore with ease. The division of anatomical regions ensures a clear and immediate visual 

grasp of each structure, while the option to hide individual bones facilitates focused study. 

Intelligent rotation streamlines navigation by automatically adjusting the center of rotation. 
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The Interactive Pin feature is a standout, enabling users to access terms related to specific 

anatomical details, enriching the learning experience. 

The multi-language support of "Skeleton" caters to a diverse audience, with 11 languages 

available, including Latin, English, French, German, Italian, Portuguese, Russian, Spanish, 

Chinese, Japanese, and Korean. Users have the flexibility to select their preferred language 

directly from the app interface. 

 

PROS 

Within "Skeleton - 3D Atlas of Anatomy," each specific part of the human skeleton is 

thoughtfully equipped with an interactive pin feature. This unique functionality empowers 

users to select and explore individual anatomical components, unraveling a wealth of 

information about each part. By engaging with these pins, users can conveniently access 

and unveil the precise names associated with different anatomical structures. 

The clarity and realism of the 3D models within the application are noteworthy. Crafted 

with meticulous attention to detail, the anatomical representations are not only visually 

clear but also remarkably realistic. Users can expect a lifelike and immersive experience 

as they delve into the intricacies of the human skeleton. The advanced rendering 

capabilities bring each bone to life, allowing users to gain a comprehensive understanding 

of the skeletal system with unparalleled clarity 

 

 

CONS 

While "Skeleton - 3D Atlas of Anatomy" offers an impressive interactive pin feature 

allowing users to select specific parts of the human skeleton, there are notable areas that 

could benefit from improvement. When a bone is selected, the current interface lacks 

detailed information and fails to distinctly highlight the chosen area within the 3D model. 
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This absence of clear visual indication may potentially lead to confusion for the user, as 

they may struggle to correlate the named part with its exact location on the anatomical 

model. 

Moreover, the application currently lacks a note-taking feature, depriving users of the 

ability to personalize their learning experience by jotting down observations, questions, or 

additional information related to specific anatomical structures. The inclusion of a note- 

taking capability would significantly enhance the educational value of the app, allowing 

users to engage more deeply with the content and tailor their learning journey to individual 

preferences.
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2.2.3 Complete Anatomy 2023 

 

Figure 2.2.3-1 Complete Anatomy 

 

Figure 2.2.3-2 Complete Anatomy Femur Selected 
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Figure 2.2.3-3 Complete Anatomy Femur Learning 

 

Figure 2.2.3-4 Complete Anatomy AR View 
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Complete Anatomy 2023" by 3D4Medical stands as a cutting-edge and comprehensive 

anatomy application, offering a wealth of features that cater to a diverse audience of 

medical professionals, educators, and enthusiasts. The application boasts highly detailed 

gross 3D anatomy models that provide users with a realistic and immersive exploration of 

the human body. 

 

PROS 

Notably, the application provides label viewing tools, allowing users to delve into the 

detailed nomenclature associated with different anatomical structures. Enhancing 

personalization, the inclusion of text box sketching enables users to annotate and highlight 

specific areas directly on the 3D models, fostering a more interactive and engaging learning 

environment. The inclusion of microscopic anatomy further enriches the educational 

content, offering insights into cellular and tissue-level structures. 

 

One of the standout features of the application is its accessibility across all devices, 

ensuring users can seamlessly access its content on various platforms. Drawing inspiration 

from the esteemed Gray's Anatomy, the app's atlas provides accurate representations of 

human anatomy. With an extensive library encompassing over 1,500 videos and more than 

100 courses, learners have access to a diverse range of educational resources. 

 

"Complete Anatomy 2023" stands out with dynamic cross sections, allowing users to 

explore anatomical structures layer by layer, and interactive radiology images that enhance 

the diagnostic aspect of the application. The inclusion of licenses for in-person 

presentations, patient education, and online/video call presentations reflects its versatility 

in catering to different educational settings. 
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Another one of the groundbreaking features of this application is its capability to simulate 

dissections virtually. Users can explore internal anatomy dynamically, gaining a 

comprehensive understanding of anatomical relationships. Taking it a step further, the 

application introduces an innovative bone fracture simulation, allowing users to visualize 

and comprehend the effects of bone fractures—an invaluable tool for medical education 

and pathology exploration. 

 

CONS 

One notable drawback of the "Complete Anatomy 2023" by 3D4Medical is its high price 

point, presenting a potential barrier for many students who may find it challenging to afford 

such an investment. While the application offers a wealth of features, including various 

anatomical systems and cutting-edge tools, the cost may limit accessibility for a significant 

portion of the student population. 

 

The price factor could be a major concern, especially for students who are often operating 

within tight budgets. Access to comprehensive educational resources, particularly in the 

field of medicine and anatomy, is crucial for effective learning. The high cost may 

unfortunately restrict the app's availability to a narrower demographic, potentially 

excluding those who could benefit most from its advanced features. 
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Table 2.3-1 Comparison between Similar Application 

Applications 

Functions 

AR 

Anatomy 

Skeleton Complete 

Anatomy 2023 

Proposed 

Application 

AR Types Marker-Less 

AR 

Not 

Implemented 

Marker-Less 

AR 

Marker-Less 

AR 

Able to make 

Notes 

✗ ✗ ✓ ✓ 

Information and 

Labeling 

✓ ✗ ✓ ✓ 

Extra Information - Clinical 

notes 

Facts 

✗ Clinical notes 

• Facts 

• Treatments 

videos 

• Condition 

videos 

• Exercise 

Videos 

• Streches 

Videos 

 

 

 

✓ 

Human Femoral 

Fractures Info 

✗ ✗ ✗ ✓  

Offline Available ✓ ✓ ✓ ✓  

Cost Free   Free  Costly  Free  

 

2.4 Femur Fracture 
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2.4.1 Study of Human Femur Fracture 

Femoral shaft fractures exhibit a diverse array of patterns, each offering unique insights 

into the nature and magnitude of the forces that lead to such injuries. 

One of the most common femoral shaft fractures is Transverse fractures, characterized by 

a straight horizontal break, typically result from direct forces applied perpendicular to the 

femur's longitudinal axis. 

On the other hand, oblique fractures showcase an angled line along the shaft, indicating the 

influence of angular forces during the traumatic event. 

The distinctive candy cane-like appearance of spiral fractures signifies a rotational or 

twisting force impacting the thigh. 

Comminuted fractures, with the bone fragmenting into multiple pieces, often signify high-

energy trauma, emphasizing the severity of the applied force. 

After that, Linear fractures in the femoral shaft occur when there is a straight, horizontal 

break across the bone. The line of the fracture runs perpendicular to the long axis of the 

femur. These fractures can result from a direct impact or force applied to the femur. 

Besides, Greenstick fractures are incomplete fractures, common in pediatric populations 

where bones are more flexible. In a greenstick femur fracture, the bone is bent, causing a 

crack on one side while the other side remains intact. This type of fracture resembles the 

way a green twig breaks, hence the name. 

Among these, open or compound fractures present a particularly intricate scenario, where 

a bone fragment breaches the skin or a wound extends to the fractured site. Such fractures 

involve heightened complexity, as the risk of complications, especially infections, is 

elevated, demanding thorough clinical attention. Recognizing and understanding the 

nuances of these femoral shaft fractures is essential for orthopedic practitioners to tailor 

effective treatment plans, ensure optimal patient outcomes, and advance the field's 

knowledge in fracture biomechanics. 
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2.4.2 Fatality Rate of Femur Fracture 

Femur fractures, particularly in the elderly population, pose a significant risk to overall 

health and survival. The 1-year case fatality rate for patients with femur fractures has been 

reported to be alarmingly high, ranging from 20% to 24% [16] This elevated mortality rate 

underscores the severe impact of femur fractures, often exacerbated by underlying health 

conditions and complications arising from the injury. Factors contributing to this high case 

fatality rate include the increased risk of postoperative complications, such as infections 

and cardiovascular events, as well as the challenges in mobilizing and rehabilitating 

patients who are often frail and have other comorbidities. These statistics highlight the 

urgent need for improved management strategies and preventative measures to enhance 

patient outcomes and reduce the mortality associated with femur fractures. 
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CHAPTER 3 

Proposed Method/Approach  

3.0 Objective and Vision 

The primary goal of this project is to develop an Augmented Reality (AR) application 

focused on the human femur and its fractures. The app will provide an immersive, 

interactive educational experience for medical students and educators, allowing them to 

explore femur anatomy, interact with 3D models, and compare different fracture types. It 

will be accessible on mobile devices, ensuring broad usability and convenience. 

 

3.0.1 Key Features 

• Interactive 3D Models: High-resolution 3D models of the human femur, allowing 

users to rotate, zoom, and isolate specific parts for detailed study. 

• Educational Annotations: Detailed descriptions and annotations on different parts 

of the femur, providing in-depth information on anatomy, common injuries, and 

treatments. 

• Comparison of multiple femur Fractures: Ability to spawn multiple femur 

fractures side by side, helping users understand the differences and implications of 

each fracture type. 

 

 3.0.2 Development Strategy 

Platform Selection: 

o The application will be developed using Unity, which supports cross-

platform development, allowing for deployment on both Android and iOS 

devices. 

o Unity AR Foundation will be used to implement AR functionalities, 

ensuring compatibility with a wide range of devices. 

 

Modeling and Texturing: 
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o High-fidelity 3D models of the femur will be created using Blender or 

similar 3D modeling software. 

o Texturing and material creation will ensure realistic representation, with 

attention to anatomical accuracy. 

AR Integration: 

o Implement AR features using Unity AR Foundation, allowing users to place 

the femur model in their physical environment. 

o Ensure smooth tracking and interaction within the AR environment, using 

marker-based or world-based tracking depending on the device's 

capabilities. 

 

By following this approach, the femur AR application will not only serve as a powerful 

educational tool but also push the boundaries of how medical anatomy can be taught and 

understood through technology. 
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3.0.3 Methodology 

Before beginning the system development, selecting an appropriate methodology is crucial, 

especially for a project being built. For this project, the prototype model was chosen as the 

development methodology. The prototype model is ideal in situations where initial 

specifications are unclear, as it allows for the creation of a preliminary prototype with 

minimal requirements. This prototype is then iteratively tested and refined based on user 

feedback, ensuring that the final system meets all user requirements. 

 

Figure 3.1-1 Methodology of Proposed System 

 

Stage 1: Requirements Gathering and Analysis 

The first step in the project involves identifying user requirements. This is done by 

interviewing users or project stakeholders to understand their expectations from the system. 

Understanding these requirements helps define the project scope. Additionally, a feasibility 

study is conducted to assess the project's technical aspects, estimated costs, and potential 

benefits. If the project is deemed feasible, it moves on to the next stage. 
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Stage 2: Design, Prototyping and Evaluation (quick design) 

In the second stage, the processes of design, prototyping, and evaluation are closely 

interwoven. An initial design is created early in this stage, leading to the development of a 

prototype. This prototype allows project stakeholders to interact with a realistic version of 

the software, ensuring that the requirements are being met and providing a basis for 

evaluation. Often, users will suggest additional requirements or modifications, prompting 

the development of a new prototype. This cycle of design, prototyping, and evaluation 

continues until the users are satisfied with the system. 

 

Stage 3: Implementation and Maintenance  

Once the final system has been fully tested by both developers and project stakeholders to 

ensure it meets all requirements and performs without errors, it is ready for implementation. 

Following deployment, a maintenance phase may be conducted to address any issues that 

arise with the developed system. 

 

 

 

 

3.1  System Requirement 

3.1.1  Hardware 

The hardware involved in this project is computer and android mobile device. A computer 

issued for the process of 3D visualization and segmentation from MRI and CT datasets to 

obtain the 3D model objects, then it also used for applying AR technology on the 3D model 

objects. A mobile device is used for testing and deploying this AR application in learning 

human anatomy 
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Table 3.1 Specifications of laptop 

Description Specifications 

Processor Intel Core i3-12300 

Operating System Windows 11 

Graphic AMD Radeon RX 5600XT 

Memory 16GB DDR4 RAM 

Storage 1TB SATA SSD 

 

 

 

 

 

 

3.2.1 Technologies Involved 

 

Table 3.2.2 Tools and Software 

 

Tools / Software Description 

Unity 

 

 

 

 

 

 

Unity is a cross-platform game engine that is currently 

commonly used in developing video games. It supports both 

the 2D and 3D environments for PC and mobile 

development. The native programming language used in 

Unity is C#. It will be used as the main development tool 

for developing the 3D educational mobile application for 

femoral shaft fractures. 
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Visual Studio 2022 

 

 

 

 

 

 

 

 

 

Visual Studio 2022 is an IDE mainly for the purpose of 

coding, and there are several languages supported in it, such 

as C#, C++, Python, Node.js, and others. It also can be used 

to develop mobile apps, websites, web apps, web services, 

and computer programs. It will be used for coding the 

scripts for making the mobile application function well. 

Blender 

 

 

 

 

 

 

 

Blender is a free and open-source software for 3D 

environments, such as modelling, rigging, animation, 

rendering, compositing, motion tracking, as well as video 

editing. It will be utilised for modelling the types of fracture 

bones. 

C# programming language 

 

 

C# is natively supported by Unity, and with Visual Studio 

2022, some user-interaction features of the mobile 

application will be programmed in C#. 

Firebase 

 

 

 

 

 

 

Firebase is a NoSQL cloud-hosted database that is used to 

store, sync, and query app data on a large scale. It will be 

used to sync data from PlayerPrefs and store it in the cloud 

to prevent data loss in the event that the application is 

removed or reinstalled. 
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Unity AR Foundation 

 

 

 

 

 

 

 

 

 

 

 

AR Foundation is a package that lets you build cross- 

platform AR applications in Unity3D.you can develop 

your AR application in Unity3D and then build it either 

for Android or iOS.Vast community support, easy 

access to Unity3D codebase & asset store 

It will be used for simulating AR Enviroment 
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3.3 User Requirements 

3.3.1 Functional Requirements 

3D Model Interaction 

• Users can spawn and manipulate 3D models in AR space 

• Multi-touch gesture support for model manipulation: 

• Double-tap to place or relocate objects 

• Touch and drag for rotation 

• Two-finger pinch for scaling 

• Long-press (0.7 seconds) for object deletion 

• Support for multiple object variants (e.g., femur models) 

• Maximum of 2 objects can be displayed simultaneously 

• Objects automatically orient towards the camera for optimal viewing 

• Toggle movement mode for precise object positioning 

Object Management 

• System maintains object spawn order queue 

• Automatic removal of oldest object when limit is reached 

• Object position persistence during session 

• Support for cycling between different prefab models 

• Collision detection and physics interactions 

• Automatic scaling based on predefined factors 

AR Environment Integration 

• Plane detection for object placement 
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• Raycast-based object positioning 

• Height offset adjustment for floating objects 

• Support for AR Foundation framework 

• Material and renderer management 

3.3.2 Non-Functional Requirements 

Performance 

• Touch response time under 100ms 

• Smooth gesture recognition 

• Efficient object spawning and destruction 

• Enhanced touch support for precise interactions 

• Movement threshold of 10 pixels for drag detection 

Reliability 

• Error handling for missing components 

• Consistent object state management 

• Logging system for debugging and monitoring 

Usability 

• Intuitive touch gesture controls 

• Clear visual feedback for user actions 

• Consistent UI button placement 

• Predictable object behavior 

• Short learning curve for basic interactions 

• Clear distinction between interaction modes 
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CHAPTER 4 

System Design 
4.1 System Flow Chart 

Figure 4.1-1 Main Flow Chart 
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The main application flowchart illustrates the core navigation and learning features of the femur 

study app. Upon starting the application, users are greeted with background music and a menu 

offering several parallel options: studying an intact human femur bone, exploring different types 

of femoral shaft fractures, or viewing general information. If the user chooses to study an intact 

femur, they can interact with a 3D model, access basic information, and add notes. Selecting 

femoral shaft fractures leads to a choice among four fracture types, each converging at a single 

point before allowing the user to interact with a 3D model of the selected fracture, review detailed 

information, and add notes. Viewing general information simply displays the relevant content. All 

user paths eventually merge at a common endpoint, ensuring a consistent and unified user 

experience. 
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Figure 4.1-2 AR Feature Flow Chart 
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The AR feature flowchart details the process when a user selects the augmented reality option 

from the menu. The application opens the camera and continuously scans for a horizontal surface 

to establish an AR plane. Once a suitable plane is detected, the user can double-tap to spawn a 

femoral fracture model into the real-world environment. The user is then able to interact with 

this AR object—rotating, scaling, or cutting it—using the available controls. This interaction loop 

continues until the user decides to exit the AR mode, at which point they are returned to the main 

menu. This flow ensures a smooth and immersive AR experience, seamlessly integrated with the 

app’s overall structure. 
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4.2 System Architecture Diagram 

 

Figure 4.2-1 System Architecture Diagram 

 

User Interface 

This is the front-facing component where users interact with the AR application. It includes 

all the visual and interactive elements that the user sees and uses, such as buttons, menus, 

and the display of the AR environment. 

Bone Module 

This is the core module of the system, focusing on the AR interaction with a bone model. 

It includes various subcomponents: 
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AR Module 

The AR Module is a critical part of the system that handles all the augmented reality 

functionalities. It is broken down into three subcomponents: 

Plane Detection: Responsible for detecting flat surfaces in the real world where the AR 

content, such as the bone model, can be placed. This component uses the device’s sensors 

and camera to identify and track planes. 

Input System: Manages user inputs like taps, gestures, and other interactions within the AR 

environment. It ensures that the application responds correctly to user actions. 

Raycast: This subcomponent is used to calculate and determine where a user’s touch or 

gesture intersects with the virtual objects in the AR space. It helps in placing, moving, or 

interacting with the bone model based on user input. 

Bone Model 

This represents the 3D model of the bone that is being interacted with in the AR 

environment. The bone model is likely the primary object that users will examine, 

manipulate, or study. 

Hardware 

The hardware component refers to the physical devices involved in running the AR 

application. It includes: 

Camera: The device’s camera is essential for capturing the real-world environment and 

overlaying the virtual bone model onto it. The camera feeds the necessary data for plane 

detection, raycasting, and overall AR functionality. 
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4.3 Activity Diagram 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.3-1 Activity Diagram 

Start the AR Scene: 

The AR application initializes, setting up the AR environment and preparing all necessary 

components for user interaction. 
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Initiate a Plane: 

The system scans the real world using the device’s camera to detect a flat surface (plane). 

This plane will serve as the foundation for placing virtual objects. 

Gaze Interaction: 

While the AR environment is active, the app monitors where the user is looking (gaze 

interaction). 

• If the user gazes at a specific part of the femur, the application prints out 

detailed anatomical information about that part, enhancing the educational 

experience. 

Wait for User Input: 

After the plane is established and gaze interaction is available, the app waits for further 

input from the user to perform various actions. 

User Input Actions (All in Parallel): 

The following actions can happen independently and simultaneously: 

• Cycle Button Toggled: 

If the user presses the cycle button, the app increases the index of the 

currently selected prefab, allowing the user to browse different models that 

can be spawned. 

• User Double Tapped: 

When the user double-taps the screen, the app raycasts to determine the 

exact tap position on the plane. 

• If no object is present at that location, the app spawns a new object 

there and ensures it has proper physical properties (box collider and 

mesh collider). 

• If an object already exists, the app moves the spawned object to the 

new tapped position. 
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• If the spawned object is a femur, the app enables an option for the 

user to change it to an inner bone model. 

• If User Moves Two Fingers on the Screen: 

The app detects pinch or spread gestures, and scales the object based on the 

distance between the two fingers, allowing dynamic resizing. 

• If Rotation Button is Toggled & Object Spawned: 

If the rotation button is toggled and an object is present, the app allows the 

user to rotate the object by moving a finger in a circular motion. 

• If Gaze Looked at an Object: 

Whenever the user's gaze focuses on an object, the app displays information 

about that specific part, supporting interactive learning. 
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CHAPTER 5 

 

System Implementation 

Preliminary Research is research on a topic that helps you get a better understanding on 

what types of sources are available and what is being said about a topic. This type of 

research helps solidify a topic by broadening or narrowing it down. This research can 

also help you when choosing Search Terms. 

 

5.1 Software Setup 

5.1.1 Unity Installation 

Step 1: Download Unity from https://unity.com/download#how-get-started 

 

Figure 5.1.1-1: Download UnityHub 

 

 

Step 2: Agree with License and Install UnityHub 

https://unity.com/download#how-get-started
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Figure 5.1.1-2: Agree with the License Figure 5.1.1-3: Install UnityHub 

Step 3: Open UnityHub and Install Editor

 

Figure 5.1.1-4: Select Editor Version to be Installed  
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Figure 5.1.1-5: Select Module to be Installer  

Step 4: License Activation 

  

Figure 5.1.1-6: Select Manage Licenses 
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Figure 5.1.1-7: Sign In

  

Figure 5.1.1-8: Add New License 
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Figure 5.1.1-9: Activate Free Personal License
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5.1.2 Visual Studio 2022 Installation 

Step 1: Download Visual Studio Community 2022 from 

https://visualstudio.microsoft.com/vs/ 

 

Figure 5.1.2-1: Download Visual Studio Community 2022 

 

Step 2: Install Visual Studio Installer 

 

 

Figure 5.1.2-2: Select Continue and Agree with the License Terms 

 

 

 

 

Step 3: Select and Install Workloads 

https://visualstudio.microsoft.com/vs/
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Figure 5.1.2-3: Choose the Workloads to be Installed
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5.1.3 Blender Installation 

 

Step 1: Download Blender from https://www.blender.org/download/ 

 

Figure 5.1.3-1 Download Blender 

 

Step 2: Install Blender 

Figure 5.1.3-2 Click “Next”                    Figure 5.1.3-3 Agree with the License Term 

https://www.blender.org/download/
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Figure 5.1.3-4 Browse Location for Installation 

 

Figure 5.1.3-5 Install Blender Blender Installation 
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5.2  Setting and Configuration 

 

5.2.1. Linkage between Software 

 

 

 

Figure 5.2.1-1 Relationship among the Software 

 

After installing the software needed (Unity, Visual Studio 2022, Blender), Visual Studio 

2022 is required to be linked with Unity for scripting the functions of the application, 

while Blender is used to create 3D bone model. The steps for linking the Unity and 

Visual Studio 2022 are as follow: 

Open Unity Editor 

Go to Edit > Preferences > External Tools 

Set the External Script Editor as Visual Studio Community 2022 
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Figure 5.2.1-2 Linkage between Visual Studio and Unity 

 

Before developing the application, 3D models of the bones should be prepared, where 

Blender had been chosen for creating the models in this project. After the models are 

created, the models are exported to the Unity project as .fbx file. The steps of exporting 

the models are as follow: 

In Blender, go to File > Export > FBX 

Select Unity project folder (In my case, I created and saved the models in a folder named 

“bones” in the “prefabs” folder of the Unity project. To only export the models, I ticked 

the checkbox of “Selected Objects” during exporting.) 
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Figure 5.2.1-3 Export models from Blender to Unity 

 

5.2.2. Device Simulator Setup 

Besides, since this project is going to be developed on mobile platform, a device 

simulator is needed to test if the application is work in different mobile devices. The 

steps to install the device simulator in Unity are as follow: 

Go to Window > Package Manager 

Choose “Unity Registry” 

Look for “Device Simulator” 

Go to “Advanced > “Show preview packages” (if “Device Simulator” not found) 

Install it, then the simulator option should appear in “Game” 

 

(In my case, I already installed, hence, it shows “up to date” rather than “install”) 
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Figure 5.2.2-1 Installation of Device Simulator 

 

Figure 5.2.2-2 Simulator Option Appeared 
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5.2.3. AR Foundation Setup  

Since this is an AR project, we will need an AR SDK to develop the application. The 

following steps guide you through setting up AR Foundation in Unity: 

Go to Window > Package Manager. 

In the Package Manager, search for and install the following packages: 

• AR Foundation 

• ARCore XR Plugin (for Android)  

Go to File > Build Settings. 

For Android, make sure to set the Minimum API Level to 7.0 (API Level 24) or higher. 

Then, under Project Settings 

Ensure that ARCore Supported is enabled under XR Plug-in Management. 

 

Figure 5.2.3-1 AR Foundation Successfully installed 
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Figure 5.2.3-2 Minimum Android Api Set at 7.1 

 

Figure 5.2.3-3 ARCore enabled in XR Plug-in 
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5.3. System Operation 

 

Figure 5.3-1 Menu Selection 

Access the Menu: Open the application or software where you need to select 

Augmented Reality. 

 

Navigate to the AR Option: Look for a section or menu related to Augmented Reality. 

This might be labeled as "AR," "Augmented Reality," or something similar. 

 

Select Augmented Reality: Click or tap on the Augmented Reality option to activate or 

configure AR features. 
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Figure 5.3-2 Plane Detected 

Initiate Plane Detection: Start the plane detection process within your AR application. 

 

Wait for Detection: Allow the system to scan the environment. The application will 

analyze the camera feed to identify horizontal surfaces. 

 

Detection Confirmation: Once the system successfully detects a plane, it will be 

highlighted or visualized on the screen. 

 

Plane Visualization: A visual representation of the detected plane will appear, 

indicating the detected surface where AR objects can be placed. 
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Figure 5.3-3 Object Spawned 

Double-Tap to Spawn: Double-tap on the detected plane using your device's screen. 

 

Object Appearance: Upon double-tapping, an AR object will be spawned and 

positioned on the plane where you tapped. 
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Figure 5.3-4 Object Scaled 

Scale Using Two Finger: the object can be scaled by pinching to shrink or spreading to 

enlarge it. 
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Figure 5.3-5 Object information displayed 

Information Overlay: When the gaze is detected on the object, relevant information 

about the object will be displayed. 

 

View Details: The information overlay will provide details such as the object's name, 

description, or other pertinent data. 

 

Maintain Gaze: Keep gazing at the object to keep the information displayed. The 

overlay will disappear once you move your gaze away. 

 

 



 
CHAPTER 4 

87 
Bachelor of Computer Science (Honours)  

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
 

 

Figure 5.3-6 Change to Inner Bone 

Change to Inner Femur Anatomy: Tap on the Switch Button which will change the 

Femur To Inner Femur Anatomy. 



 
CHAPTER 4 

88 
Bachelor of Computer Science (Honours)  

Faculty of Information and Communication Technology (Kampar Campus), UTAR 
 

 

Figure 5.3-7 Comparison of Fractures 

Cycle though Bones: Tap on the cycle Button to change the type of bone to be spawn 

 

Spawn the First Bone: Tap on the screen to place the first fractured bone in the AR 

environment. 

 

Repeat for Additional Bones: Tap again on different locations in the AR space to spawn 

additional fractured bones. Each bone can be of a different type or the same type for 

comparison. 

 

Arrange for Comparison: Move and arrange the spawned fractured bones to view and 

compare them easily. Use any provided tools or features in the AR app to position the 

bones as needed 
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Figure 5.3-8 Back To Main Menu 

Going Back to the Menu: Press Back On the side of button, which will bring user 

back to the main menu 
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Figure 5.3-9 NOF Fracture List 

Showing the List of NOF fractures: Press on the NOF Fracture button and a list of 

different type of NOF fracture will be shown. 
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Figure 5.3-10 NOF Fracture Shown 

Showing the NOF fracture: Press on button in the NOF fracture list and the type of 

NOF Fracture is shown for user 
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CHAPTER 6 

System Testing and Evaluation 

6.1.  System Testing 

To ensure the reliability and robustness of the AR features developed in this project, 

comprehensive system testing is essential prior to release. The primary testing approach 

selected for these AR functionalities is a combination of user case testing and black-

box testing. This strategy is designed to thoroughly evaluate the AR system from the 

perspective of end users, ensuring that all functional requirements are met in real-world 

scenarios. 

User case testing involves designing and executing test cases that reflect typical user 

interactions with the AR application. These scenarios include actions such as spawning 

AR objects, cycling through different prefabs, interacting with UI panels, and utilizing 

dropdown menus. By simulating real user behavior, user case testing helps verify that 

the system responds appropriately and intuitively to all expected actions, providing a 

seamless and satisfying user experience. 

Black-box testing is employed to validate the AR system without any knowledge of 

the underlying code or implementation details. Testers provide various inputs through 

the AR interface—such as tapping on the screen to place objects, pressing buttons to 

cycle prefabs, or selecting options from dropdown lists—and observe whether the 

outputs and behaviors align with the expected results. For example, testers check that 

AR objects appear at the correct scale and position, that UI panels display and fade as 

intended, and that error messages are shown when necessary. This approach is 

invaluable for ensuring that the system meets its functional requirements and behaves 

correctly from the user’s perspective. 

By combining user case testing and black-box testing, the AR features are rigorously 

evaluated in a manner that closely mirrors actual usage. This approach increases 

confidence that the application will perform reliably and intuitively for end users. Any 

issues discovered during these tests can be addressed early, leading to a more stable and 

user-friendly AR experience upon release. 
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6.2. Testing Setup and Result 

6.2.1. Testing Setup 

1. Enable Developer Mode on the Phone (if not already enabled) 

• Go to Settings > About Phone > Tap "Build Number" 7 times until developer 

mode is activated. 

• If already enabled, you can skip this step. 

2. Enable USB Debugging 

• On your phone, go to: 

Settings > System > Developer Options > Enable "USB Debugging" 

• Confirm any permission dialogs that appear. 

3. Connect the Device 

• Plug your phone into your laptop via a USB cable. 

• Allow USB debugging permission if prompted on your phone. 

4. Build & Run the App 

• Back in the Build Settings window: 

o Select your connected device from the Run Device dropdown. 

o Click Build and Run. 

• Choose a folder to save the APK, and Unity will build and install the app on 

your phone. 

5. Testing on Device 

• Once installed, the app should launch automatically on your phone. 

• Use touch or stylus input to interact with the AR environment (e.g., scaling, 

moving models). 
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6.3. Testing Result 

6.3.1. Prefab Spawning 

TC1.1.1: On tap, a prefab is spawned at the detected AR plane position. 

Spawn Prefab on AR Plane: Allows the user to place a 3D object (prefab) into the AR 

environment by tapping on a detected plane. Ensures correct positioning, scaling, and 

orientation for immersive interaction. 

Use Case: Spawn Prefab on AR Plane 

Actor: User 

Preconditions: AR session active, plane detection enabled 

Main Flow: 

1. User taps on screen where AR plane is detected 

2. System checks if MAX_OBJECTS limit is not reached 

3. System calculates spawn position (plane position + floatHeight) 

4. System instantiates selected prefab 

5. System applies correct scale based on prefab index 

6. System orients object towards camera 

7. System updates internal object tracking 

Expected Output: Prefab appears at tap position with correct scale and orientation 

Alternative Flow: 

1a. No plane detected at tap position 

   - No object is spawned 

 

TC1.1.2: Only allowed number of objects (e.g., MAX_OBJECTS = 2) can be spawned; further 

taps do not create more. 

Enforce Object Limit: Prevents clutter by limiting the number of spawned objects. 

Ensures only a set number of prefabs can exist in the scene at once. 

Use Case: Enforce Object Limit 

Actor: System 

Preconditions: MAX_OBJECTS objects already spawned 

Main Flow: 
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1. User attempts to spawn new object 

2. System checks current object count 

3. System identifies oldest object 

4. System removes oldest object 

5. System spawns new object 

Expected Output: New object appears, oldest object is removed 

Alternative Flow: 

1a. Object count is NOT at MAX_OBJECTS 

   - System spawns new object 

 

6.3.2. Prefab Cycling 

TC1.2.1: Pressing the cycle button updates the selected prefab and updates the UI text. 

Cycle Through Prefabs: Lets the user switch between different object models available 

in the application, enhancing interactivity and exploration. 

Use Case: Cycle Through Prefabs 

Actor: User 

Preconditions: Prefab list initialized 

Main Flow: 

1. User presses cycle button 

2. System increments SelectedPrefabIndex 

3. System updates UI text 

4. System shows fade panel with new prefab name 

Expected Output: New prefab selected, UI updated 

 

TC1.2.2: Cycling wraps around after the last prefab. 

Wrap Prefab Selection: Ensures smooth cycling through available objects. After the last 

prefab, selection wraps to the beginning to maintain continuity. 

Use Case: Wrap Prefab Selection 

Actor: System 

Preconditions: Last prefab selected 
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Main Flow: 

1. User presses cycle button 

2. System increments SelectedPrefabIndex 

3. System applies modulo operation 

4. System updates to first prefab 

Expected Output: Selection wraps to first prefab 

 

TC1.2.3: Cycling triggers the fade panel with the correct prefab name. 

Trigger Fade Panel on Prefab Cycling: Improves UX by displaying the name of the 

currently selected object through a fade-in animation panel when switching prefabs. 

Use Case: Trigger Fade Panel on Prefab Cycling 

Actor: User 

Preconditions:  

- AR session is active 

- PrefabTextFader component is properly initialized 

- At least one prefab is available in the prefabs list 

- Current prefab is selected (SelectedPrefabIndex is valid) 

Main Flow: 

1. User presses the cycle button to change prefab 

2. System increments SelectedPrefabIndex 

3. System gets the new prefab name from prefabs[SelectedPrefabIndex].name 

4. System calls prefabTextFader.ShowPrefabText(newPrefabName) 

5. Fade panel displays the new prefab name 

6. Fade panel animates according to its configured duration 

7. Fade panel completes animation and becomes hidden 

Expected Output: 

- Fade panel appears with new prefab name 

- Text is clearly visible 

- Fade animation plays smoothly 

- Panel disappears after animation completes 
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6.3.3. Prefab Deletion 

TC1.3.1: Deleting an object removes it from the scene and updates internal data 

structures. 

Remove Prefab from Scene: Allows the user to remove objects from the AR scene, 

freeing up space and managing scene clutter. 

Use Case: Remove Prefab from Scene 

Actor: User 

Preconditions: Prefab exists in scene 

Main Flow: 

1. User triggers delete action 

2. System removes object from scene 

3. System updates internal tracking 

4. System updates object spawn order 

Expected Output: Object removed, internal state updated 

Alternative Flow: 

1a. Object doesn't exist 

   - System logs warning 

   - No action taken 

 

 

Test Case Use Case Preconditions Main Steps Expected 

Result 

Status 

TC1.1.1 Spawn 

Prefab on 

AR Plane 

AR session 

active, plane 

detection enabled 

Tap on 

screen → 

Check 

object 

count → 

Calculate 

position → 

Spawn 

prefab → 

Apply scale 

& 

orientation 

Prefab 

appears at 

tap 

position 

with 

correct 

settings 

Passed 
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TC1.1.2 Enforce 

Object 

Limit 

MAX_OBJECTS 

reached 

Tap on 

screen → 

Identify 

oldest 

object → 

Remove 

oldest → 

Spawn new 

object 

New object 

appears, 

oldest 

removed 

 Passed 

TC1.2.1 Cycle 

Through 

Prefabs 

Prefab list 

initialized 

Press cycle 

button → 

Increment 

index → 

Update UI 

text 

New 

prefab 

selected, 

UI updated 

 Passed 

TC1.2.2 Wrap 

Prefab 

Selection 

Last prefab 

currently selected 

Press cycle 

→ 

Increment 

index → 

Modulo 

operation 

applied 

Prefab 

selection 

wraps to 

first item 

 Passed 

TC1.2.3 Trigger 

Fade Panel 

on Cycling 

AR session 

active, fade panel 

initialized 

Press cycle 

→ Update 

index → 

Fetch new 

name → 

Trigger 

fade panel 

Fade panel 

displays 

prefab 

name with 

smooth 

animation 

 Passed 

TC1.3.1 Remove 

Prefab 

from 

Scene 

Prefab exists in 

scene 

Trigger 

delete → 

Remove 

object → 

Update 

tracking 

and order 

Prefab 

removed, 

internal 

state 

updated 

 Passed 
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CHAPTER 7 

Conclusion and Recommendation 

7.1. Conclusion 

The integration of Augmented Reality (AR) in the medical field, particularly in the 

study and treatment of femur fractures, represents a significant advancement in both 

educational and clinical practices. This project aims to address the existing challenges 

in accurately diagnosing and understanding femur fractures by developing an 

interactive AR application that enhances the learning experience and improves patient 

outcomes. 

 

Through this research, we have identified the limitations of traditional methods in 

providing the necessary precision for understanding femur anatomy and fractures. The 

proposed AR application is designed to fill this gap by offering real-time, high-

resolution, 3D visualizations of femur fractures, allowing users to explore and analyse 

various fracture types in an immersive environment. This tool will not only aid in 

medical education by providing detailed anatomical information and fracture 

mechanics but will also support clinicians in making more informed decisions during 

diagnosis and treatment planning. 

 

During the development of this project, I encountered several significant challenges. 

One of the most demanding aspects was learning a new application from scratch while 

simultaneously retracing previous development steps to integrate AR functionality. The 

lack of comprehensive documentation and limited knowledge of the three applications 

involved further complicated the process, causing delays and requiring considerable 

problem-solving. The most significant hurdle, however, was learning C# from the 

ground up, as it is the primary language used in this development. This steep learning 

curve posed a major obstacle but ultimately became an essential part of advancing the 

project. 

 

In conclusion, the "Augmented Reality Exploration of Human Femur Fractures" project 

has the potential to revolutionize the way femur fractures are studied and treated. It 

bridges the gap between technology and medical science, providing a valuable resource 
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for medical professionals, educators, and students. The project's emphasis on 

accessibility and innovation ensures that it will have a lasting impact on the field of 

medical education and practice. 

 

7.2. Recommendation 

The AR femur fracture application, while already functional, presents numerous 

opportunities for further enhancement. Based on user feedback and technical evaluation, 

several key areas for development have been identified. To begin with, the content 

library could be expanded to include a broader range of bone types and interactive 

elements. Incorporating real-world case studies and supplementary reference materials 

would greatly enhance the application's educational value while preserving its intuitive 

and user-friendly interface. 

In terms of interactivity, the application could introduce several features to boost user 

engagement, such as controllable video playback for personalized learning pace, 

advanced note-taking with formatting options, tools for inserting images and drawings 

for annotations, interactive highlighting of bone structures for in-depth anatomical 

exploration, and an expanded quiz database offering various question types. 

From a technical standpoint, improvements should focus on optimizing AR 

performance and ensuring system stability. Enhancing error handling and feedback 

mechanisms, refining data management and storage, integrating support for diverse 

device capabilities, and enforcing more rigorous testing and quality assurance processes 

would contribute to a more robust and reliable experience. 

User experience can be further refined by streamlining navigation and simplifying 

interface interactions. Introducing more intuitive model manipulation controls, 

customizable learning paths, improved accessibility features, and enhanced visual 

feedback for user interactions would result in a smoother and more engaging experience. 

To elevate the educational value of the application, structured learning modules should 

be developed alongside comprehensive assessment tools and progress tracking systems. 

Incorporating collaborative learning features and expert commentary would further 

enrich the learning process. Together, these enhancements would significantly improve 
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the application's functionality, educational impact, and overall user experience while 

remaining aligned with its core goal as a medical learning tool. 
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